Did You Know.. About Carlson’s
Export to KMZ (Google Earth)
Command?

Carlson Software gives you the ability to export drawing
entities directly to the Google Earth application or,
alternatively, to a .kml or .kmz file that can be opened in
Google Earth. At this time Carlson supports the export of
points, polylines, text, solids, images, lines and arcs to
Google Earth or .kml/.kmz files.

In Carlson 2014 they have also included the option of sending
the Google Earth file directly to a Dropbox account for sharing
with clients or other project team members.

The Export to Google Earth command is found in the File menu in
all Carlson desktop programs.
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Year End Specials for Carlson
Software

Updated 11/4/2013: I've just added several more end of year
specials for Survey with IntelliCAD, Takeoff Suite,
Construction, Trench, GeoTech, Survey with IntelliCAD and
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manuals and more.. Remember to Add Coupon for best pricing!

Carlson jumped the gun a bit and announced their year-end
specials today.. Special pricing will end at noon on 12/31/2013.
In addition, all software purchases through 12/31 include 2
hours of online training.

Check out my online store and make sure to pick the item’s “Add
Coupon” button for best pricing:

Carlson Civil Suite including one year of upgrades/maintenance

Carlson Survey 2014 with embedded AutoCAD

Carlson CADNet 2014 including one year of upgrades/maintenance

CADNet is a new module for 2014 — broken out of Takeoff. CADNet
has tools for digitizing, importing raster and vector data from
images and PDFs, merging two image files, BIM data and more.
Check out this recent webinar introducing Carlson CADNet to see
how powerful it 1is.

Register for Carlson’s “What’s
New i1n 2014"” Webinar Series

As we're all getting ready for the release of Carlson’s 2014
desktop products, Carlson Software has scheduled a series of 5
lunchtime webinars to introduce new features and enhancements.
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See below for details and registration links:

Carlson Survey and Civil 2014
Wednesday, July 24th — presented by Scott Griffin, Director of
Sales

Carlson Construction 2014
Wednesday, July 31st — presented by Todd Carlson, Takeoff
Product Manager

Carlson Hydrology 2014 and all new Carlson Trench
Wednesday, August 7th — Mark Long, Developer, & Todd Carlson

Carlson Mining 2014
Wednesday, August 14th — Grant Wenker, Director, Mining Division

All new CADnet
Wednesday, August 21st — Jim Carlson, Regional Sales Director

All new GeoTech
Wednesday, August 28th — Dave Sanford, Regional Sales Director

Sneak Preview - Mass Haul
Analysis 1in Carlson 2014

Todd Carlson helped me out with a demonstration of Carlson
Takeoff a couple months ago and the company we were presenting
to was looking for some particular features in a mass haul
analysis routine. They had looked at several other programs as
well as Takeoff and had yet to find a solution to their
particular issue.
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Fast-forward about a month and Todd followed up to let us know
that the new functionality had been incorporated into the
software and would be available in Carlson Civil and Carlson
Construction/Takeoff 2014. This is a perfect illustration of how
responsive Carlson is to their customers (or even prospects, in
this case).

I asked Todd to write up a little preview of the new Mass Haul
Analysis routine we’ll see in Carlson 2014:

Mass Haul Analysis in a nutshell:

Mass Haul Analysis determines the volume and haul distance for
groups of net cut and net fill station ranges along a road.
The program calculates the optimized cut to fill movements so
that the total volume-distance moved is minimized.

New Feature:

When dealing with multiple external hauls, users can now input
the distance (and a “road conditions” factor) a borrow pit or
dump pile is from its entry station. The program will then use
this information when minimizing earth movement along the
road.

For example, as shown in the first graphic below, an image of
the area was inserted into the drawing from Google Earth or
the Esri Mapping Service. CAD polylines were sketched along
the travel paths from multiple pit locations to the project
site.

Then, purely based off stationing, borrow pit (A) may be
closer to a fill area than borrow pit (B). However, 1if the
distance from borrow pit (B) to its entry station 1is closer
than borrow pit (A)’s, the program may determine to use (B) as
the borrow pit over (A) to optimize the earth movement.


http://thatcadgirl.com/carlson-civil-suite/
http://thatcadgirl.com/carlson-takeoff/
http://thatcadgirl.com/carlson-takeoff/
http://www.googleearth.com
http://www.esri.com

HaEEEmw il g AnVBYel B2 lol+m+ BRARNCIELS!

IR 6 FERALIC

Processing station2: 22837.713
5.+ MASSHALL

Edit External Haul . x|

Station |8493.DDD

Diztanice |‘I 748 687 Set

Foad Conditions I‘I o0n

Source Type
|V'f;' [mport " Ex=port

v Setalume Limit
Wolume [CY] |5|:||:||:|

Ok, Cancel | Help |

% Carlson Software Edit ; C:\Users',Todd Carlson', AppData)\Roaming!Carlson Software\Carlson20. : N [ 53]
File Edit Settings

2 =/
= 8|Sl Gl
Open | Save | Print | Exit | Fifd |Sereen| Hide
Mass Haul Analysis -

Existing Section> C:\Users\Todd Carlson\Desktop\MassHaul\EX.sct

Final Section> C:\Users\Todd Carlson\Desktop\MassHaul\FG.sct
Total In sta Haul
cut{CY} Import Fill(C¥) Export Volume Volume Volume Overall Avg
Totals: 328638.3 426084.3 754722.6 0.00 754722.6 380.75 754341.9 4446.96

External Hauls

Station Distance(Conditions) Import Export
84+93.00 1748.69 (1.00) 100000. 00
155+27.00 10532.21(1.00) 326084.33
208+17.00 2908.12 (4.00) 0.00

,L\_I; L

| |

Learn more about Carlson Civil and Carlson Takeoff
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Carlson Software End of Year
Specials

Last week Carlson announced their end-of-year specials for 2012.
This year’s offerings include steep discounts on Carlson Civil
Suite, Survey with embedded AutoCAD, Takeoff and Survey.

All discounts will end at noon on 12/31/2012.

As with all of my pricing, I'm prohibited from advertising my
actual lowest prices so call or email for Coupon Codes for
further discounts.

$2,795 for Carlson Civil Suite (includes one year of
maintenance) — Retail price is $3,954.50

$2,295 for Carlson Survey 2013 with embedded AutoCAD — Retail
price is $2,995

$5,000 for Carlson Takeoff 2013 with IntelliCAD — Retail price
is $9,000

$6,500 for Carlson Takeoff T6 (2013) with embedded AutoCAD -
Retail price is $9,000

$875 for Carlson Survey 2013 with IntelliCAD and one-year
Maintenance for anyone who already owns SurvCE, Fast Survey or
Triton. A valid serial number is required prior to purchase.
Retail price is $1,754.50.
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Carlson Software Self-Study
Manuals

In order to reduce the amount of time I’'ve been spending in
online training, I'd been considering putting together Carlson
Software training manuals. But, in order to truly offset the
majority of the training I do, the first book had to be more
than a standard software training manual that covers a broad
range of topics.

So, I've just completed and started shipping the first 2 books
that I'm calling Self-Study Manuals. They will be a great
substitute for training for beginning users of Carlson Software
and also as “fill-in-the-blanks” training for more experienced
users. The lessons are very detailed, down to every pick and
click. You do not even need to know AutoCAD or IntelliCAD to
complete them. I think you will find them very beneficial if
you're new to Carlson or even to help bring your field crew up
to speed as office help.

At this time, there are 3 lessons available: Carlson
Configuration and CAD Settings (about 0.5 hours of instruction),
Getting Started with Points for Survey or Civil (about 4.5 hours
of instruction) and Field to Finish (about 6.5 hours of
instruction). I’'ve combined the Carlson Configuration and CAD
Settings and Getting Started with Points for Survey or
Civil into the first book and the Field to Finish is a separate
book. Additional books are on the way.. some will be detailed,
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self-study manuals and others won’t. I will be focusing on the
ones that most closely follow the demand for training.

The books can be purchased separately or as a bundle from my
online store. Introductory pricing is available through the end
of 2012.

View a sample of the Getting Started with Point Self-Study
Manual here

View a sample of the Field to Finish Self-Study Manual here

Carlson Configuration and Settings
Approximately 0.5 hours of instruction

When first launching Carlson Software, you can make changes to
the configuration and options that will apply to the current and
future drawing sessions. Some of the settings and options are
specific to Carlson Software and some are specific to AutoCAD®
or IntelliCAD®.

Part 1 of this lesson contains Carlson Software-specific
settings and is applicable to anyone using Carlson with either
an AutoCAD or IntelliCAD platform.

Part 2 contains AutoCAD-specific settings.
Part 3 contains IntelliCAD-specific settings.

Appendix A explains how to use the Project Folder method of
Project/Data File Setup as an alternative to the Drawing Folder
method.
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Appendix B explains the use of Carlson Quick Keys and how they
interact with AutoCAD and IntelliCAD command Aliases.

Carlson Survey Getting Started with Points
Approximately 4.5 hours of instruction

This lesson starts by loading a configuration file with
recommended settings and options for the program. We will also
open a few toolbars that may be needed for the exercises.

We will then start a new project and new drawing from a
text/ascii file and will draw the points with the Draw-Locate
Points command. Various point editing and reporting commands and
features will be used. Some of these features include: Point
Groups, Tag Non-Surface Points, Translate Points and Rotate
Points. In wrapping up Part 1, we will export points to a new
text/ascii file and also export the point data to a LandXML
(.xml) file. Please note that Carlson’s Field to Finish is
covered in a separate lesson.

Appendix A covers, as a separate exercise, the new Esri-powered
command Search Published Control that allows you to search
published control data that is freely available on the National
Geodetic Survey (NGS) website and then store the retrieved
information to the active Coordinate File.

Appendix B provides a separate, in-depth, explanation of the
Carlson Point Block entity and how its Symbols and Point
Attributes (Point Number, Elevation and Description) are
controlled with respect to Layers.



Carlson Field to Finish
Approximately 6.5 hours of instruction

This lesson starts by loading a configuration file that contains
recommended settings and options for the program. We will also
open a few toolbars that may be needed for the exercises.

Part 1 provides an overview of the Field to Finish feature of
Carlson® Survey. We will start a new project and new drawing
from a text/ascii file. The text file is very similar to the one
used in Lesson 2a — Getting Started with Points except that it
has been slightly modified to include special linework coding.
We will use Field to Finish so that the points, symbols and
linework are automatically generated and drawn on their proper
Layers. Field to Finish will also create Point Groups and tag
some points as Non-Surface so they can be easily excluded when
we build a surface model.

In Part 2 we will create a new Field to Finish Code Table that
includes a variety of Codes that can be used to create Symbols,
3d and 2d Linework.

In Part 3 we will simulate collecting more than 70 survey points
in the field and then processing them with the Field to Finish
Code Table created in Part 2. With this Code Table, we will
collect points for features such as roadways, buildings, trees
and property corners. We will also demonstrate the use of
Special Codes for labeling descriptive information such as %”
Iron Pipe

and 12" Oak Tree.

In Part 4 we will use the Separate Attribute Layers
functionality within Field to Finish so that Symbols and
Descriptions for points we process can be used to label features
on printed plans.



In Part 5 we will go through the steps required take some of
your existing point files to make a new Field to Finish Code
Table for your company.

Carlson 2013 Has Been Released

Carlson released the 2013 version of their desktop products
today. This includes: Civil Suite, Civil, Survey, Hydrology,
GIS, Takeoff, Construction, Point Cloud, Geology,
Surface/Underground Mining and Natural Regrade.

The 2013 embedded-AutoCAD versions of Takeoff and Survey have
not yet been released.

Unlike previous versions of Carlson that support running on top
of IntelliCAD or AutoCAD products 2000-2012, Carlson 2013 can
only be run on IntelliCAD or AutoCAD products 2004-2013. This
includes AutoCAD, Map, Land Desktop and Civil 3d. Also, anyone
using the FREE IntelliCAD that comes with Carlson is eligible
for a FREE GIS Starter Kit from Esri which includes ArcMap.

You can download Carlson 2013 here.

If you are using 2012 and are current on your annual maintenance
contract, you can click here to look up your new 2013 serial
number online. You will need to enter your contact information
and your 2012 serial number in order to generate the 2013 serial
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number. You can find your serial number by opening Carlson
Software and going to Help > About Carlson Software > Change
Registration.

If you have trouble finding your serial number or would like to
know the cost to upgrade to 2013, please email me with your
request.

Click here for the full list of improvements to Carlson 2013

Click here for improvements to the General commands in 2013

Click here for the additional data file & conversion support in
Carlson 2013

Click here for improvements to Survey commands in 2013
Click here for improvements to Civil commands in 2013

Click here for improvements to Hydrology commands in 2013
Click here for improvements to GIS commands in 2013

Click here for improvements to Takeoff commands in 2013
Click here for improvements to Point Cloud commands in 2013
Click here for improvements to Geology commands in 2013

Click here for improvements to Surface/Underground Mining
commands in 2013

Click here for improvements to Natural Regrade commands in 2013
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Intel11CAD Webinar — Do Over

Last week I presented a webinar sponsored by Carlson Software on
the topic “Updates and Overview of IntelliCAD 7”. Unfortunately
we had some technical difficulties and didn’t get a complete
recording to post to the Movies collection on Carlson’s website.

For those who are interested, we will be re-doing the webinar on
Thursday, March 29th. By that time we expect to have additional
updates and improvements to announce.

Keep an eye on this site to register for the next IntelliCAD
webinar

You can register for these future webinars by clicking the link
below:

» Tips and Tricks for Setting Points
= Debunking the “Carlson Isn’t Dynamic” Myth
= Carlson Annotation and Labeling

New Carlson Build - 120219

Carlson released a new build of their desktop software earlier
this week. This includes updates to the IntelliCAD/for AutoCAD
versions of Survey, Civil, Hydrology, GIS, Basic Mining,
Geology, Underground Mining, Surface Mining, Natural Regrade,
Field, Takeoff, Construction and Point Clouds.

To confirm your current build number, go to Help > About
Carlson. You’'ll see the build number on the top line of the text
box.
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You can download the latest full version or updates to your
current installation here.

If you would like to try out any of the Carlson Software
products for 30-days, email me here.

For those anxious to try out the very latest and greatest
updates in the testing versions of IntelliCAD 7.1, you can also
send me an email to gain access to a new blog, “The Little CAD
Engine That Could”, administered by Leonid Entov of Carlson
Software.

Participation in the testing and access to the blog is by
invitation only, so email me and I’'ll pass along your request.

Carlson 2012 Updates

You can download the most recent updates to Carlson’s 2012
desktop software HERE
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